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A. OVERVIEW 

Purpose 
The OCR-504 is a member of Satlantic's new OCR-500 micro-sensor series of 
instruments.  The OCR-504 is a fully digital optical sensor package that 
combines precision optics and high performance microelectronics.  
 

Background 
 

The OCR-504 has seven customer-defined discrete optical wavelengths, selected 
from Satlantic's standard list.  When used as a standalone instrument, Satlantic 
can configure the data interface for either the standard or micropower 
configuration.  In the standard configuration, the data interface is RS-232 
(transmit and receive) and RS-422 (transmit only), with a +6 - +16 Vdc supply 
voltage range.  In the micropower configuration, the data interface uses CMOS 
levels, with a +6 - +10 Vdc supply voltage range. 

 

Features 
 

• Can be operated as a networked or standalone instrument 
• Small size  
• Lightweight 
• Low power requirement 
• Minimal amount of support equipment required 
• Easy to use 
• Flexible electrical and mechanical configurations 
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Specifications for Irradiance Sensor - Nominal Characteristics 

Spatial Characteristics: 
- Field of view: cosine response (spectrally corrected) 
- Collector area: 86.0 mm2 
- Detectors:  custom 17 mm2 silicon photodiodes 

Spectral Characteristics:    
- Bandwidth range:  400-700 nm (standard - custom also available)  
- Number of channels:  4 
- Spectral bandwidth: 10 nm or 20nm 
- Filter Type: custom low-fluorescence interference 

Optical Characteristics:    
- Cosine response:  within 3%  0–’  60– within 10%  60–’  85– 
- Typical NEI: 8.7x10-3 uW cm-2 nm-1 

Physical Characteristics: 
- size: 46 mm diameter, 150 mm long 
- weight: 200 g (in air) 
- depth rating: 100 m 

Specifications for Radiance Sensor - Nominal Characteristics 

Spatial Characteristics: 
- Field of view: 10– 
- Detectors:  custom 13 mm2 silicon photodiodes 

Spectral Characteristics:    
- Bandwidth range: 400-700 nm (standard - custom also available) 
- Number of channels: 4 
- Spectral bandwidth: 10 nm or 20nm 
- Filter Type: custom low-fluorescence interference 

Optical Characteristics:    
 Out of band rejection: 10-6 
- Out of field rejection: 5x10-4 
- Typical NER: 300x10-6 uW cm-2 nm-1 

Physical Characteristics: 
- Size:  46 mm diameter, 150 mm long 
- Weight: 200 g (in air) 
- Depth rating: 100 m 
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Understanding OCR-504 Part Numbering 
 

The OCR-500 series of instruments are each defined by a model number.  Model 
numbers are composed of three fields containing four selectors, and has the 
format: 

 
OCR-50x-tffm 

 
Where 
 
 x NUMBER-OF-CHANNELS 
   4 (four channel radiometer) 
   7 (seven channel radiometer) 
 
 t TYPE-OF-RADIOMETER 
   I (Irradiance) 
   R (Radiance) 
   I/R (coupled Irradiance and Radiance) 
 
 ff FIELD-OF-VIEW 
   03 (3 degrees half-angle) 
   10 (10 degrees half-angle) 
   CS (cosine) 
 
 M MEDIA 
   A (air) 
   W (water) 
 
For example, an OCR-504-R10W is an OCR-500 series instrument with four 
radiance channels, each with a 108 half-angle FOV (Field-Of-View) and is 
intended for in-water use. 
 
Please note that not all OCR-504 models are physically equivalent.  For instance, 
an OCR-504 with a 38 FOV is longer than a standard 10 8FOV model. 
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Figure A-1: Configuration C1 
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OCR-504 Configuration Options 
 

The OCR-504 series of instruments are available with a number of configuration 
options, as outlined below.  These configuration options affect both the electrical 
and mechanical interface to the instrument. 

 
Please consult Satlantic if you require a special configuration. 

 
WARNING!  OCR-504 configurations may appear physically identical, but 
are electrically different.  Extreme care must be taken by the user to ensure 
that the different configurations are not confused.  For instance, a user could 
purchase an OCR-504-R10W with the C1 configuration and another 
OCR-504-R10W with the C2 configuration.  The only external difference is the 
serial number on the instrument label - the connectors are the same.  Using the 
C2 instrument with equipment set up for the C1 configuration could potentially 
place destructive RS-232 levels on CMOS pins, or exceed the allowable input 
voltage range. 
 

CONFIGURATION C1 
 

This is the standard configuration for the OCR-504 instruments.  In this 
configuration, telemetry is available at both RS-232 and RS-422 levels.  The user 
may also communicate with the OCR-504 through the RS-232 port.  The 
operating voltage range for this configuration is +6 - +16 Vdc. 

 
See Figure A-1: Configuration C1 

 
The interface to the OCR-504 is made via a Subconn MCBH-6M connector, as 
shown in the figure.   
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Figure A-2: Configuration C2 
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CONFIGURATION C2 
 

This is the micropower configuration for the OCR-504 instruments.  In this 
configuration, bi-directional communication is available at CMOS levels.  The 
operating voltage range for this configuration is +6 - +10 Vdc. 

 
See FigureA-2: Configuration C2 

 
The interface to the OCR-504 is made via a Subconn MCBH-6M connector, as 
shown in the figure.   The SCL and SDA pins are used by the OCR-500 series for 
inter-instrument communication when in Satlantic's network configuration.  
These connections should not otherwise be used. 
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Figure A-3: Configuration C3 
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CONFIGURATION C3 
 

This is the special order configuration and is electrically equivalent to 
configuration C1.  However, the interface is made using a different external 
connector, an Impulse LPMBH-6-FS, as shown in the figure.   
 
See Figure A-3: Configuration C3 
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OCR-504 Telemetry 
 

Telemetry from the OCR-504 is organized into frames.  The OCR-504 provides a 
frame synchronization string or "header" (a "unique" sequence of bytes) to allow 
our software to detect the beginning of a data frame.  The frame itself consists of 
a number of binary data "fields" as defined by the OCR-504's calibration file.   

DATA FORMAT 
 

The OCR-504 data format is binary at 57600 baud (normal), with no parity, 8 
data bits, and 1 stop bit. No hardware handshaking is used. Data transmission 
should be automatic when the unit is turned on, after a short delay. 

 
The frame format is as follows 

Field Field 
Size 
(bytes) 

Field Name Description 

1 6 INSTRUMENT The frame synchronization string marking the 
beginning of the data frame. The  characters 
are unique for the instrument.   

2 4 SERIAL NUMBER The instruments 4-digit serial number. 
3 2 ADDRESS The instruments unique network address. 
4 2 FRAME TYPE The data frame type from the instrument. 
5 2 FRAME LENGTH The number of bytes in the data frame. 
6 3 AUX The upper 3 bytes of the frame counter. 
7 1 FRAME 

COUNTER 
Frame counter that increments with each 
frame sent, from 0 to 255. When 255 frames 
are sent, the counter resets to 0. The frame 
counter is useful tool for determining when 
and where data loss occurs. 

8 1 SUB FRAMES Number of sub frames in this frame. 
9 1 VERITY BYTE Causes sum of bytes in frame to be 0. 
10 4 CHANNEL1 Data from optic channel 1. 
11 4 CHANNEL2 Data from optic channel 2. 
12 4 CHANNEL3 Data from optic channel 3. 
13 4 CHANNEL4 Data from optic channel 4. 
14 2 VS Supply voltage measurement. 
15 2 TEMP On-board temperature measurement. 
16 2 CRLF Carriage return - line feed terminator. 

 
Total number of bytes in the frame: 44.  This information is contained in the 
calibration file. 
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B. SAFETY & HAZARDS 

Personal Safety 
 

Ø The operators should always remain aware of the cable.  Any cable or line 
released from a ship can be dangerous.  Keep a safe distance from the cable 
coil on deck when the instruments are being used. 

 

Instruments 
 

Ø Do not leave instruments in direct sunlight on deck when not in use.  
Extreme heat (35°C or greater) can potentially damage them. 

 
Ø When using an in-water reference, do not leave the reference unattended.  

Boat drift can entangle the cable and cause damage or instrument loss. 
 

Cable 
 

Ø Ensure the power/telemetry cable is not pinched or bent to a radius less than 
18 cm, to prevent damage to the conductors within the kevlar strength 
member. 

 

Connections 
 

Ø Handle electrical terminations carefully, as they are not designed to 
withstand strain.  Disconnect the cables from the components by pulling on 
the connector heads and not the cables.  Do not twist the connector while 
pulling, as this will damage the connector pins. 

 
Ø Do not use petroleum-based lubricants on connectors.  Connectors should be 

free of dirt and lightly lubricated before mating.  We recommend using 
DC-111 silicone grease (made by Dow-Corning) on the male pins prior to 
connection.  
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Troubleshooting 
 

Ø While checking voltages with a multimeter, extreme care should be used so 
as not to short the probe leads.  A shorted power supply or battery can output 
many amperes of current, potentially harming the user, starting fires, or 
damaging equipment. 

 

Recovery 
 

Ø Remember never to grab the electrical portion of the profiler or reference 
cable during recovery.  This can cause damage to the power/telemetry 
bulkhead and the underwater splice. 

 
Ø Lens caps should always be replaced as soon as the instrument comes back 

on board.  This will help protect the heads from direct damage. 
 
Ø Be sure to rinse sea water from the instrument with fresh water prior to 

storage.  Corrosion resulting from failure to do so is not covered under 
warranty. 
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C. START UP 

Assembly Procedure 

PREPARATION 
 
The OCR-504, when used as a standalone instrument, is very simple to set up.  
The normal user requirements are 

 
• DC power source (+6 -+10 Vdc or +6 - 16 Vdc, depending on configuration) 
• PC with free communications port to log data 
• Power/telemetry cable (may be provided) 
• Data-logging program (provided) 
• Data conversion program (provided) 

 
Satlantic provides the SatView data display and logging program, along with the 
SatCon data conversion program.  Virtually any PC running Windows'95 or 
Windows'98 is adequate for these programs.  Please refer to the SatView and 
SatCon manuals for more detail.  Note that it is not necessary to use SatView to 
log data - essentially any terminal emulator can be used.   

 
Note that if the C2 configuration is being used, a CMOS to RS-232 converter 
will be required to log data with a PC.  Similarly, if it is desired to use the 
RS-422 telemetry in the C1 or C3 configuration, a RS-422 to RS-232 
converter will be required. 
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CONNECT COMPONENTS 
 

When making connections, proper alignment on the connector pins is critical to 
avoid damage.  Visually ensure that the pins on the male connectors are properly 
aligned with (and partially seated into) the sockets on their female counterparts 
before pushing them together for final connection.  Finally, ensure that the 
locking sleeve or locking strap is securely fastened after connection. 
 
Following is a generic step-by-step procedure for setting up an OCR-504.   
1. Disconnect the OCR-504 interface cable (if connected). 
2. Ensure external power supply is set up for the proper voltage. 
3. Ensure power is OFF. 
4. Mount the OCR-504 in the desired position. 
5. Connect the interface cable to the bulkhead on the OCR-504. 
6. Connect the interface cable to a spare com port on the PC for data display 

and logging, with the appropriate level converter (if required) 
7. Set up the data display/logging program.  If you are using Satlantic's 

preferred SatView software, please refer to the SatView manual for details. 
8. Remove the protective cover from the end of the OCR-504. 
9. Apply power to the OCR-504. 

 
After a brief delay, telemetry should begin to be received from the OCR-504.  If 
you do not receive any telemetry, remove power to the OCR-504, and repeat the 
given procedure.  If you still do not receive telemetry, please contact Satlantic for 
assistance. 
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CONDUCT A SIMPLE TELEMETRY TEST 
 

A simple telemetry test should be conducted to get familiar with the data logging 
software and to test the system for proper operation prior to deployment.  This 
test assumes that the OCR-504 is in the C1 configuration and is used as a 
standalone instrument.  OCR-504 data can be viewed in real time and logged 
using SatView, Satlantic's Windows'95/98 based data logging and display 
software package.  SatView is provided with the OCR-504 on two 3.5" diskettes.  
The calibration file, on a 3.5" diskette, is also provided.  Additional calibration 
information and a hard copy of the calibration file, are included with the diskette.  
Load the SatView program and copy the calibration file onto the computer prior 
to the test outlined below.  Here, we assume that a user created folder 
C:\OCR500 is the working directory 
 
1. Start SatView by selecting Start -> Programs -> Satlantic -> SatView.  

You should see: 
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2. Select Setup -> Resource List, as shown: 
 

 
 

3. In the Communications Resources dialog, select the add button to add the 
communication port that will be used to log data.  Here, COM1 is assumed.  
Setup the port for 57600 baud, as shown 
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4. Select OK, then click the Display button in the Communications Resources 
dialog.  You should see the COM1 Control Panel, as shown.  Drag the 
window to a convenient location on the desktop, and close the 
Communications Resources dialog box. 

 

 
 
 

5. Next, you need to set up SatView with the calibration file supplied with the 
OCR-504.  The calibration file you receive will be different than that shown 
here, but the procedure is the same.  Select Setup -> Add Instrument. 
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6. You should see the Add New Instrument dialog box.  Select From 
Calibration File, and browse to the location of your calibration file, as 
shown.  The name and location of your calfile will be different from that 
shown in the dialog. 

 
 

7. The main SatView window should now appear as follows: 
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8. Right-click on the OCR-504 in the instrument list (SATDx4xxxx) and select 
Properties.  Set up the dialog as shown: 

 

 
 

9. If you are using a port other than COM1, select it from the drop down list.  
Select OK to close the dialog. 
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10. Next, double click on the OCR-504 in the instrument list (SATDx4xxxx).  
The SATDx4xxxx dialog box should appear: 

 
11. Double-click on each of the views in the view list to display the data for that 

view.  Arrange the windows as is convenient on the desktop. 
 
12. From the SatView main window, select Setup -> Connect All.  This 

connects the communication resource to the communications port, allowing 
telemetry to be received.  Provided the OCR-504 is powered up and 
configured properly, you should now be recieving telemetry in SatView.  The 
Frames Read field in the Control Panel should be incrementing, as shown. 
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13. As an extra convenience, SatView allows you to save this setup for the next 
time you use the OCR-504.  Go to File -> Save As and save the setup in a 
convenient location with a descriptive name, such as "OCR504.sat" in the 
SatView directory.  The next time you wish to use the OCR-504 with 
SatView, simply open this file and all settings will be restored.  Please refer 
to the SatView manual for more details. 

 
14. Shown is a typical SatView session with the OCR-504. 
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D. OPERATION 

Logging Telemetry with SatView Software 
 

1. SatView provides a very simple method for logging OCR-504 telemetry.  
After setting up SatView as described in the previous section, select Log -> 
options from the main SatView window.  The Logging Options dialog 
should appear. 

 
Set the logging mode to NONE, the file naming mode to USER DEFINED, 
and set the log directory as desired.  The window should appear similar to 
that shown.  Select OK when complete. 

 
2. In the SatView main window, click the Edit button next to the Next Log 

field.  Type a name for our test log file, say OCR500Test, then hit enter 
(SatView will append .raw to the file name). 
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3. The Start Logging button is now available in the SatView window.  When 
you are ready to begin logging, simply click this button.  The log button 
should change to Stop Logging, and the Log Timer field will show how 
long SatView has been logging data.  In the Control Panel window, the 
Frames Rec. (for frames recorded) field should be incrementing.  When 
sufficient data has been logged (3 - 5 minutes) simply click the Stop 
Logging button. 
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As shown here, the logged raw file is present in the selected directory.   

 
 

SatView provides many more telemetry logging options that are beyond the 
scope of this manual.  Please refer to the SatView manual for more detailed 
instructions. 

Data Processing with SatCon Software 
 

After logging telemetry with SatView, the OCR-504 data is stored in 
uncalibrated digital counts.  Satlantic's SatCon data processing software is 
provided for converting the raw log file into a usable format.  SatCon reads the 
instrument calibration file, applies the appropriate conversion coefficients and 
formulae to the raw binary data and writes the data back out in calibrated 
physical units to an ASCII text file.   
 
This section outlines the procedure to conduct a simple SatCon session, assuming 
that the file OCR500Test.raw was logged as outlined above.  SatCon has a great 
number of features that are not discussed here; please refer to the SatCon manual 
for detailed operating instructions. 

 
1. To start using  SatCon, select Start -> Programs -> Satlantic -> SatCon.  

The main SatCon window should now be displayed, as shown below. 
 

 



SYSTEM 

OCR-504 Optical Sensor 
 

 
  

SECTION 
D.    OPERATION 

 

Revision: B Document #: SAT-DN-0034 - Copyright °  2000 by Satlantic -  Page: D-4 
 

2. From the Conversion heading, select Parameters.  The Conversion 
Parameters dialog box should be displayed.  Set up the options as shown, 
then click OK. 

 

 
 

3. From the Conversion heading, select File Naming.  The Output File 
Naming dialog should be displayed.  Set up the options as shown below.  
This configures the output ASCII file to be named based on the calibration 
file name concatenated with the logged data file name, with a .dat extension.  
Select OK when complete. 
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4. SatCon must be instructed as to where to look for  the calibration file and log 
file, as well as where to put the output file.  In this example, we will assume 
that the directory C:\OCR500 is being used.  From the main SatCon window, 
select View -> Properties.  The File List Properties dialog will be 
displayed.  First, select Log Files from the drop down list, and change the 
working directory to wherever the logged data is stored.  Don't exit the dialog 
yet. 

 
 
5. Select Instrument Files from the drop down list and again change the 

working directory to where the calibration file is stored.  Don't close the 
dialog box yet. 
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6. Select Output Files from the drop down list and once again change the 
working directory to where you want the converted file to be placed. 

 

 
 
 

7. When you are happy with these settings, click OK.  The main SatCon 
window should now look similar to the following: 

 

 
 

As you can see, the Log Files list contains the .raw file, the Instrument 
Files list contains the .cal calibration file, and there are no output files 
present since no conversion has been performed yet.  Since multiple .raw and 
.cal files can exist in the same directory, the user must single-click the 
appropriate .raw and .cal file so that they are highlighted as shown.  Notice 
that the Next: field contains the name of the output file that is about to be 
generated.   
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8. SatCon is now ready to convert the binary data into ASCII format.  From the 
Conversion heading, select Convert.    The SatCon Conversion dialog 
should be displayed, indicating the conversion progress, the number of 
frames processed, and any frame counter errors detected.  Click OK when the 
conversion is complete. 

 
 
 

9. The main SatView window should appear as shown.  Notice the converted 
log file is shown in the Output Files list. 
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10. If you check the destination folder, you can confirm that the .dat ASCII 
output file is indeed present. 

 

 
 

SatCon can now be exited and the output .dat file can be loaded into a 
spreadsheet or other data processing program. 
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E. RECOVERY 
 
To recover the OCR-504 when it is used in the water, terminate data logging and 
pull the sensor back in using the cable.  Disconnect the cables from the 
components taking care to pull without twisting on the connector heads, not the 
cables.  Replace any dummy connectors and the vinyl end cap to protect the 
instrument during storage. 
 
Always be sure to rinse the instrument with fresh water prior to storage in order 
to prevent corrosion. If there is any seawater in contact with the instrument in 
storage, particularly around bolts and other contacts of dissimilar materials, 
corrosion may occur. To not properly rinse the instrument before storage is 
considered misuse and warranty claims cannot be made under such 
circumstances. 
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F. MAINTENANCE 
 

Preventative Maintenance 
 

The OCR-504 requires virtually no maintenance.  Ensure the instrument is not 
impacted and that any seawater is rinsed off after use.  The dummy connectors 
and vinyl end cap should be replaced before storage.   
 

Troubleshooting with HyperTerminal 
 

Occasionally, new SatView users may experience difficulty configuring the 
program properly in order to view and log OCR-504 telemetry.  Windows'9x 
includes the HyperTerminal program for serial data communication.  This 
program provides a useful tool for quickly checking to see if telemetry is being 
received from the OCR-504. 

 

CHECKING FOR HYPERTERMINAL INSTALLATION 
HyperTerminal may not be installed on your computer.  It is, however, a standard 
part of Windows'9x.  Check to see if HyperTerminal is installed by entering 
Start -> Programs -> Accessories.  If a HyperTerminal folder is visible in the 
Accessories folder, HyperTerminal is already installed. 
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INSTALLING HYPERTERMINAL 
 

Adding HyperTerminal is very straightforward; open up the Control Panel and 
click on the Add/Remove Programs item. Go through the dialogs as shown to 
install the program. 
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CONFIGURING HYPERTERMINAL 
 

To start the HyperTerminal program, go to the Start menu and select Run, then 
type hypertrm in the Run dialog box. An alternative method is to enter the 
HyperTerminal folder through Start -> Programs -> Accessories -> 
HyperTerminal, then double-clicking on the hypertrm.exe icon.  At startup, 
HyperTerminal initiates a configuration with a new connection dialog box. It is 
helpful to create an informative name for the connection we are about to create, 
as shown in the following figure. The name as shown indicates that we will have 
a connection to a OCR-500 instrument, on COM1, at 57600 baud. 
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The phone number dialog box will then open. HyperTerminal is biased towards 
telephone and modem based connections, but for an OCR-500 series instrument a 
direct connection is required. We need to avoid any automatic search by the 
program for a modem and select a direct COM port connection.  Below we see 
that Com 1 has been selected. 
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Finally HyperTerminal will ask for the asynchronous serial port communication 
parameters that will be used in the connection. This is shown in the COM1 
Properties dialog box (below).  The properties required for the OCR-500 are as 
follows: 57600 bits per second, 8 data bits, no parity, 1 stop bit, and no flow 
control.  You do not need to use the Advanced button in this dialog box (if 
present).   
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After completing this dialog and pressing the OK button, HyperTerminal's main 
window will be displayed, as shown below.  If the OCR-500 has been configured 
correctly and is turned on, the output telemetry stream should now be visible, as 
shown.   

 

OCR-500
Frames
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At this point the connection will be established and it should be possible to see 
telemetry from the OCR-500.  However, the configuration process is not yet 
complete. The program is currently configured to auto-detect the type of terminal 
that it should be emulating. This is inappropriate for use with the OCR-500 and 
may cause problems. To correct this, from the File menu you should click the 
Properties selection and change the terminal type. Select the Settings tab of the 
dialog box and change the Emulation from Auto Detect to TTY as shown.  
Setting the emulation type to VT100 also works well. 
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If the OCR-500 has been set up properly, when you press the OK button you will 
see telemetry as shown in the previous figure.  Sometimes you will not be able to 
see some or all of the headers; this is often due to carriage return characters being 
present in the data frame, causing HyperTerminal to overwrite the headers.  
Occasionally simply changing the emulation type to something else (such as 
VT100 instead of TTY) alleviates the problem.  If not, you can also append line 
feeds to incoming line ends.  From the same window where the emulation type 
was set, press the ASCII Setup button.  Check the box that says, "Append line 
feeds to incoming line ends", as shown below.  This should allow you to easily 
see most headers. 

 

 
 

Troubleshooting for Hardware Problems 
 

If, after running Hyperterminal, telemetry is not visible in the HyperTerminal 
window, there could be a hardware problem.  The connections can be checked 
and voltage checks can be conducted on the cables and components, as outlined 
below. To check voltages, a multimeter with DC voltage measurement, resistance 
measurement, and continuity check capability is required. 

 
WARNING!  While checking voltages, extreme care should be used so as not to 

short the probe leads.  A shorted power supply or battery can 
output many amperes of current, potentially harming the user, 
starting fires, or damaging equipment. 
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CHECK CONNECTIONS 

Procedure 
1. Ensure power cable is properly connected to the power supply and the 

instrument 
2. Ensure the RS-232 or RS-422 cable is connected to the correct PC 

communications port. 
3. Ensure no other programs are running that could be using the 

communications port. 

CHECK THE SUPPLY  VOLTAGE TO THE OCR-504 
 

Voltages above the maximum input voltage may damage the instrument and 
voltages below the minimum operating voltage may cause the device to drop out 
of regulation.  Thus the user should ensure the voltage input to the OCR-504 is 
within the allowed range as specified by its configuration (see section A). 

Procedure 
1. Set the multimeter to measure a DC voltage. 
2. If using a battery as the power source, measure the voltage directly at the 

battery terminals with the multimeter.  If the voltage is low then recharge or 
replace the battery.  If using a DC power supply, set the output voltage to the 
proper range and check the voltage with the multimeter. 

3. Connect the power supply cable to the power source. 
4. Being extremely careful not to short the probe leads, measure the voltage 

between the pins on the supply cable.  It should read approximately the same 
as the measurement taken in step 2.  If the voltages are not the same, recheck 
the power supply cable connections.  If they are still not the same, there is 
likely a break in the cable that requires repair (a wire break can be confirmed 
with a continuity check). 

5. If the voltage is ok, connect the power supply cable to the OCR-504. 
6. Again measure the voltage at the power supply terminals.  The voltage 

should remain approximately the same as before, although there may be a 
small voltage drop when using a battery (battery voltage drops under load).  
If there is a significant voltage drop, disconnect the power immediately and 
check for shorts in the cable. 
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CHECK CABLE CONTINUITY 
 
Often, system problems can be traced to cable breaks or shorts.  Usually, these 
cable failures are a result of improper handling or storage.  Cable continuity can 
be checked as outlined below. All the cables should be disconnected from the 
instrument when performing these tests.   

Procedure 
1. Set the multimeter to measure continuity.  The resistance measurement 

setting can also be used. 
2. Check for continuity by measuring from pin 1 on one end of the cable to pin 

1 on the other end.  The meter should confirm that the connection is 
continuous by either giving an audible signal or measuring a low resistance.  
If there is not continuity, there is a break in the cable requiring repair. 

3. Repeat step 2 for all pins in the cable. 
Check for shorts from pin 1 to all other pins by keeping one probe lead on 
pin 1 and touching the other probe lead to each of the other pins in the same 
connector in turn.  All pins should be isolated from each other.  The meter 
should read this as open or measure a very high resistance.  If any of the pins 
are not isolated, there is a short in the cable that requires repair. 
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G. WARRANTY 
 
Warranty Period 
 

The OCR-504 is under one year parts and labour warranty from date of purchase.  
 
Restrictions 
 

Warranty does not apply to products that are deemed by Satlantic to be damaged 
by misuse, abuse, accident or modifications by the customer. The warranty is 
considered void if any optical or mechanical housing is opened. In addition, the 
warranty is void if the warranty seal is removed, broken or otherwise damaged.  

 
Provisions 
 

During the one year from date of purchase warranty period, Satlantic will replace 
or repair, as deemed necessary, components that are defective, except as noted 
above, without charge to the customer.  

 
Returns 
 

To return products to Satlantic, whether under warranty or not, contact Satlantic, 
Customer Support Department and request a Returned Material Authorization 
(RMA) number and provide shipping details. All claims under warranty must be 
made promptly after occurrence of circumstances giving rise thereto and must be 
received by Satlantic within the applicable warranty period. Such claims should 
state clearly the product serial number, date of purchase (and proof thereof) and a 
full description of the circumstances giving rise to the claim. All replacement 
parts and/or products covered under the warranty period become the property of 
Satlantic Inc. 

 
Liability 
 

IF THE OCR-504 SHOULD BE DEFECTIVE OR FAIL TO BE IN GOOD WORKING 
ORDER THE CUSTOMER'S SOLE REMEDY SHALL BE REPAIR OR REPLACEMENT 
AS STATED ABOVE.  IN NO EVENT WILL SATLANTIC INC. BE LIABLE FOR ANY 
DAMAGES, INCLUDING LOSS OF PROFITS, LOSS OF SAVINGS OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OR 
INABILITY TO USE THE OCR-504 OR COMPONENTS THEREOF. 
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H. CONTACT INFORMATION 
 

If you have any problems, questions, suggestions or comments about the 
instrument or manual, please contact us.  

 
Location 
 

Satlantic Inc. 
Richmond Terminal, Pier 9 
3481 North Marginal Road 
Halifax, Nova Scotia 
B3K 5X8 Canada 
 
PHONE: (902) 492-4780 
FAX: (902) 492-4781. 
 
Email: info@satlantic.com 
Web: http://www.satlantic.com 

 
Business Hours 
 

Satlantic is normally open for business between the hours of 9:00 AM and 5:00 
PM Atlantic Standard Time. The Atlantic Standard Time zone is one hour ahead 
of the Eastern Standard Time zone. Normally, in the winter, AST is UTC-4, but it 
changes to UTC’3 during the daylight saving time period in the summer. 
Daylight saving time is in effect from 2:00 AM on the first Sunday in April until 
2:00 AM on the last Sunday in October. 
 
Satlantic is not open for business during Canada%s statutory holidays, which are 
as follows: 
 
• New Year's Day  January 1st 
• Good Friday   The Friday before Easter Sunday  

(Easter Sunday is the first Sunday after the full 
moon on or following March 21st, or one week 
later if the full moon falls on Sunday) 

• Victoria Day   The first Monday before May 25th  
• Canada Day   July 1st  
• Halifax Natal Day   The first Monday in August 
• Labor Day    The first Monday in September 
• Thanksgiving Day   The second Monday in October 
• Remembrance Day   November 11th  
• Christmas Day   December 25th  
• Boxing Day   December 26th 



SYSTEM 

OCR-504 Optical Sensor 
 

 
  

SECTION 
I.    MANUAL REVISIONS 

 

Revision: B Document #: SAT-DN-0034 - Copyright °  2000 by Satlantic -  Page: I-1 
 

I. MANUAL REVISIONS 

 

Date Author Rev Comments 
2001-08-28 SKF B Added Manual Revisions section. 

Updated Satlantic contact information. 
Updated telemetry baud rate references to 
57600 baud. 

 


